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News and Events: 
  

??  Microsoft is doing some interesting software development to give similar functionality as 
the "Sling box".  It offers the promise of watching your recorded TV shows over the 
Internet from anywhere. 

http://www.betanews.com/article/MS_Testing_Media_Center_TV_Streaming/1137177825 
?? Bill Gates keynote at CES 2006 was pretty cool.  Media Center fans will find much of the 

content very promising.  Windows Vista looks like a huge improvement in so many ways.  
Check it out here if you're interested. 

http://www.microsoft.com/events/executives/billgates.mspx 
?? We think TiVo has finally lost what was left of it's collective mind.  New pricing schemes 

offer a free box if you'll pay a higher monthly fee.  Why would anyone do this unless they 
really hate the DVR from their cable/satellite provider?  The blog buzz is hinting strongly 
that TiVo may be in big trouble with their shareholders, partners and the press. 

http://www.pvrwire.com/2006/02/27/under-pressure-tivo-may-begin-offering-free-pvrs/ 
?? Archos has released a new video player the Archos AV500.  The acknowledged leader in 

portable media players has scored another home run! 
?? It looks like the PlayStation 3 is going to be delayed for nearly a year.  Hard to believe 

that Sony will let XBox go unchallenged that long. 

http://news.com.com/PlayStation+3+may+be+delayed+a+year/2100-1043_3-
6041327.html?tag=nefd.top 

?? Dolby has announced a new Dolby HD Audio specification for optical players.  The new 
system offers 7.1 discrete channels of lossless audio.  The release promises that this 
technology will reach into our PCs very soon.  If it is true it would then be possible to 
nearly match the original fidelity of the movie audio track. 

http://investor.dolby.com/ReleaseDetail.cfm?ReleaseID=182983 
 

?? This article ties in nicely with our feature topic on the launch of HD DVD.  Yet more 
confusion reigns with getting all the specifications and players to play nicely together 
including HDMI and Dolby Digital. 

http://www.guidetohometheater.com/news/020506hdmi/ 

?? An interesting viewpoint from a die hard MythTV fan.  He decided to hold a winner takes 
all showdown between Media Center and MythTV. 

http://www.notpopular.com/blog/comments.php?blogID=68 

?? Ever wondered how to choose an HDTV OTA antenna?  HDBeat has a great overview 
here. 

http://www.hdbeat.com/2006/01/30/ota-hd-demystified/ 



  

?? Anthony Park (and Chris Lanier) have developed a web browser for use within Media 
Center - so you don't have to leave to surf. 

http://www.anpark.com/software.aspx 

  
November’s Feature Topic - High Definition DVD 
This month the new High Definition DVD titles and players are hitting the market.  We figured this 
was a great time to bring everyone up to speed so you can decide whether it makes sense to 
jump in on the bleeding edge or wait until things shake out. 
  
The Background 
  
It has been several years since the DVD format came to market.  At the time of launch, the DVD 
format and hardware represented a giant leap forward from VHS tape formats and hardware.  It 
offered digital storage, longer storage life and higher resolution pictures.  We have all enjoyed the 
benefits of DVDs.  The downside was that the format was created before the rapid adoption of 
high definition television displays.  DVD is formatted at 720X480 resolution so it looks great on a 
standard TV.  On a high definition display a DVD movie looks noticeably inferior to a high 
definition broadcast movie.  Another drawback to the format is that the media (disc) only supports 
around 4.5 GB of storage (around 9 GB for dual layer DVDs), so there is a serious limitation to 
the amount of high definition video it can hold. 
  
The Issue 
  
The consumer has rapidly adopted high definition televisions and the FCC has mandated high 
definition broadcasting from the broadcasters.  The movie studios want to feed the apettite for 
high definition movies too.  Needless to say the hardware manufacturers want to cash in on high 
definition player sales as soon as possible. 
  
Sounds like everyone wins right? 
  
Once again there is a fly in the ointment of consumer electronics technology - the dreaded format 
war! 
  
The Japanese consumer electronics companies decided to have a format war rather than agree 
on a unified format for high definition DVDs.  This has resulted in two competing technologies - 
Blu-Ray and HD DVD.  Both formats use a blue laser (different frequency) rather than a red laser 
like standard DVDs.  The blue laser can burn more bits onto a disc to support the storage 
demands of high definition video.  Unfortunately they use different lasers and discs. 
  
Formats? 
  
Why are formats important and how do they affect us?  Remember when digital technology was 
first touted as the next big thing?  We were all promised nifty little discs that would hold 
everything and play in everything.  Our music, computer files, videos, everything! would fit on a 
disc that could be used in our computers, music players, cars, etc.  We wouldn't ever be faced 
with another 8-track tape or Betamax disaster again right?   
  



Well it didn't exactly work out that way.  Instead we have CDs, DVDs, mp3 players and so on.  All 
of these cost money and work with different hardware devices.  The manufacturers like this 
system because they can sell more hardware, players and discs.  The content providers are less 
happy since formats cost them money to produce and if a format fails to win consumer support 
can lose them a lot of money.  This is offset somewhat by the fact they sold us the same song on 
record, tape, CD or download.  The retailers can get stuck with a lot of useless inventory 
(whatever happened to all those LP records sitting at WalMart?).  
  
For the consumer it is also a two-edged sword.  We get better quality content (looking and 
sounding better all the time) that theoretically will last our lifetimes.  On the other hand, we have 
to keep upgrading the hardware and rebuying the content in many cases.  We also get burned in 
several ways if we are early-adopters.  Sometimes the formats fail completely and we have to eat 
our investment (how many of you purchased a Betamax or a Laser-disc movie player?_.  
Sometimes the technologies themselves are full of problems and we become lab rats for the 
hardware and software manufacturers.  Worst of all we pay outrageous prices for the equipment 
and content (remember when a cheap DVD player was $199 instead of $30). 
  
Formats really do matter because they represent technological improvement with massive 
potential downsides to our wallets. 
  
In the case of high definition DVD this is definitely the case.  The competing technologies offer 
improvements but more than likely one or both will become obsolete very quickly.  You some 
decisions to make - Should you go into this technology now or wait until one wins?  If you go now, 
which one should you choose? 
  
HD DVD 
  
HD DVD is a format developed by Toshiba and NEC.  It uses the same sized disc as a standard 
DVD but can fit up to 30GB of video and audio. 
  
The movie studios supporting this format (producing HD DVDs of their movies) are Time Warner 
(Warner Bros., HBO, New Line Cinema), Universal (Dream Works) and Paramount.  Around 60 of 
the top 100 movies (rated by the American Film Institute) will be produced in this format. 
  
Strengths:  

?? An easy name to understand.  We aren't kidding!  Names are important for consumer 
adoption by non-technical people and this name is easily understood. 

?? Easily manufactured by studios and disc makers with existing equipment. 
?? Good support among several top studios. 
?? Fully supports Mandated Managed Copies - You can make a backup copy and use it in 

portable players or stream it on your home network for instance. 
?? Uses iHD specification and language. 

Weaknesses: 

?? Less studio support will mean fewer titles initially. 
?? Smaller storage capabilities mean that it could become obsolete more quickly if content 

requirements change. 
Blu-Ray 
  
Blu-Ray is a format developed by Sony and supported by Dell, Hewlett Packard, LG Electronics, 
Matsushita, Philips and Pioneer.  It uses a different-sized disc than a standard DVD but can fit up 
to 50GB of video and audio.  Most movies won't exceed 25 GB however. 



  
The movie studios supporting this format (producing HD DVDs of their movies) are Sony 
(Columbia, Tri-Star), Twentieth Century Fox and Disney.  Around 40 of the top 100 movies (rated 
by the American Film Institute) will be produced in this format.  This format has wider support 
from studios so more new releases should be supported than with HD DVD. 
  
Strengths: 

?? Has more studios lined up to release titles. 
?? More storage space available. 
?? Written in Java so should be easily supported by OEMs. 

Weaknesses: 

?? Name isn't easily understood - will need to explain what a Blu-Ray disc is. 
?? Requires new equipment to produce new disc size. 
?? Smaller laser aperture is causing higher failure rates in production (problem may be 

fixable but is currently a large weakness). 
?? Uses the European JEM specification which could cause player recognition issues for 

some hardware manufacturers. 
?? Fox studios has forced additional copyright protections above AACS protection - This 

additional digital rights management scheme could restrict or eliminate Managed Copies.  
There are rumors that this DRM scheme has delayed the Playstation3 development cycle 
since a Blu-Ray player will be included. 

Hardware 
  
Toshiba's first HD DVD players go on sale any day now and will be priced at $799 for the home 
theater model and $499 for the basic model with less A/V interconnection options.  Blu-Ray 
players should hit the market in May or June with the Pioneer player retailing for $1,800. 
  
Conclusion 
  
Consumers will eventually be the winner from this competition because one or both of these 
formats could be dismantled in the marketplace.  With any luck the financial ramifications will hurt 
the losing formats supporters so badly that we won't see a format war for quite some time.  There 
really shouldn't have been a war in this case since both formats are so very close to offering the 
same thing - the studios and hardware manufacturers deserve to feel some pain for encouraging 
the conflict. 
  
So should you wait to see which one wins?  Our answer is yes, absolutely!   
  
If money is no object then jump in and make your bet on which one will win.  Which one should 
you buy?   
  
Like choosing XBox360 (available now) or waiting for Playstation3, it is a tough call. 
  
We're going to recommend Blu-Ray.  Not because it is better (We in fact think HD DVD made all 
the right calls on specifications and feature support whereas Blu-Ray blew it and then 
compounded their problems by messing with additional DRM) but because it can offer more 
content more quickly.  We take our position based upon past history.  Betamax was first to market 
- a Sony product :) for those counting - but was trounced because VHS could offer more movie 
titles more quickly.  We believe that all things being equal "content is king"...we'll be rooting for 
HD DVD because they actually tried to go with consensus specifications and keep a format war 
from ever happening.  That's our opinion and we could be wrong. 



 
Tip for February 
  
 
For those of you who installed the Media Center Rollup 2 and we're having problems with content 
restriction and blue screens with HBO, we recommend the following fix.  We have tested this on 
our machines and it worked (the hotfixes and reinstallation never worked on our machines but 
feel free to try them).  Please create a system restore point before making any of the changes 
recommended here. 
  
1. Attempt to backup your licenses in Windows Media Player (didn't work for us but it's worth a try 
for you) 
a.Open WMP 
b.On the Tools menu click on Manage Licenses 
c.Click Back Up Now.  Close WMP. 
2.  Click on Start and select Run.  Type "net stop ehRecvr" without the quotes 
3.  Click OK to run it.  You will see a black box popup saying that the media service has been 
stopped. 
4.  Click on Start and select My Computer. 
5.  From the Tools menu select Folder Options. 
6.  From the Folders Options window select the View tab. 
7.  From the View tab, click on the checkbox to "Show hidden files and folders" 
8.  Click on the checkbox next to "Hide protected operating systems files (Recommended)" to 
uncheck this setting.  When prompted with the warning click on Yes. 
9.  Click on the Apply button and then click the OK button. 
10. From the My Computer window double click on the C: Drive icon (or whatever your operating 
system drive letter is).  Next click on Documents and Settings.  Next click on All Users.  You 
should now see a folder labeled "DRM".  Right click on this folder and select delete.  You want to 
delete the entire folder.  The folder will be recreated automatically when you run Media Center 
again. 
11. After deleting the folder you should go back into the Folder Options, View tab and check on 
the box to select "Hide protected operating system files" so you don't mistakenly delete anything 
else. 
12.  You can now restore your licenses if the backup in step 1 worked.  Otherwise, we 
recommend that you restart your computer, create another restore point and then enjoy HBO in 
Media Center! 
  
Hopefully MS will complete their bugfix soon so everyone can get a stable rollup without these 
messy DRM problems. 
  
What’s new from Media Made Easy 
  
Media Made Easy is set to release our newest media system.  The HDTV Server is a gigantic 
leap forward in power and performance.  Featuring video driven by a GeForce 7800GTX and 
onboard storage capacity of 1.5 TB, this system takes no prisoners.  With two standard and two 
high definition tuners it is a TV junkies dream.  Check it out at 
http://www.mediamadeeasy.net/HDTV.htm 
  
Introductory offer for all newsletter subscribers! 
  
Order a Media Made Easy HDTV Server by March 30th, 2006 and receive a free iPod Nano 
2GB.  If you're interested please contact us. 
  



Have questions, comments or ideas for us?  Please email us with request for topics for the next 
newsletter.  We want to get you the information you’ve been looking for.  You can reach us at 
newsletter@mediamadeeasy.net. 
  
You can find us on the Internet at http://www.mediamadeeasy.net/ 
You can call us at (912) 537-3230. 
 


